
Prepare for File Transfer

1. Make sure the remote device has file sharing enabled.  It must support the OBEX File Transfer server profile.

Note: If the other device is also using the Bluetooth Connection Kit, you can enable file sharing by tapping the Bluetooth icon.  
In the pop-up menu, tap Transfer via Bluetooth | Enable File Sharing.

2. Now you are ready to browse the remote device.  Tap on the Bluetooth icon.  In the pop-up menu, tap Transfer via Bluetooth 
| Browse Remote Device.

3. If your mobile computer has no devices in the Bluetooth Devices Folder that supports OBEX File Transfer, then it will begin 
to search for Bluetooth devices nearby.

4. Select the Bluetooth device you wish to browse.  If the desired device is not listed, tap Find.

5. Your mobile computer will begin to establish a file sharing connection.
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6. After the devices successfully connect, the Bluetooth File Explorer will appear.  Half of the screen shows contents of the 
remote device, while the other half shows contents of your device (the local device).  The very bottom of the screen reports 
the connection status.

Send/Receive File(s) or Folder(s)

1. Select the file(s) or folder(s) that you wish to transfer.  You can only select items from one device per transfer session.

Single-tap items to select them for transfer.

Double-tap on a folders to open it and see its contents.

2. There are two different ways to initiate the transfer.

• Tap on the File menu.  Select Send to remote or Get from remote, as applicable.  The inappropriate option should be gray.
• Tap on the Send to remote icon or Get from remote icon, as applicable.  The inappropriate icon should be gray.
3. A screen will report the status of the transfer.
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4. After the transfer, a copy of each selected item should appear in the other device.

Create a Folder

1. Tap on the File menu.  Select Remote device or Local device, wherever you want to create a folder, then tap Create remote 
folder or Create local folder, as applicable.

2. Alternatively, on the Dolphin 9500/9550, you can tap and hold your stylus on an item in either the remote or local device that 
you wish to put in a new folder.  In the pop-up menu, select Create folder.

3. In the next screen, enter a name for your new folder.  Tap OK.

4. The new folder should be listed under the appropriate device.

Delete File(s) or Folder(s)

1. Select item(s) that you wish to delete.  You can only delete item(s) from one device at a time.

2. Tap on the File menu.  Select Remote device or Local device, wherever the item(s) are located, then tap Delete remote 
item(s) or Delete local item(s), as applicable.
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3. Tap and hold your stylus an item in either the remote or local device that you wish to put in a new folder.  In the pop-up 
menu, select Delete folder.

4. In the Confirm screen, tap Yes.

Refresh Remote View

1. Tap on the Device menu.  Select Refresh remote view.

2. Your local device will begin to read the contents of the remote device.

3. After a few seconds, the view of the contents of the remote device will be refreshed.

Connect/Disconnect

To connect to the remote device, do the following:

1. Make sure the remote device has file sharing enabled.

2. Start the connection process by either of two methods:

• ·Tap on the Device menu.  Select Connect.
• ·Tap on the Connect icon.

3. In the next screen, select the device you wish to connect to.  Tap Select.  Your mobile computer will attempt to connect to the 
device selected.

To disconnect from the remote device, do the following:

1. Start the disconnection process by either of two methods:

• Tap on the Device menu.  Select Disconnect.
• Tap on the Connect icon.
2. Your mobile computer will disconnect from the remote device.  Afterwards, no contents will be listed for the remote device.
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Exit Bluetooth File Explorer

To exit the Bluetooth File Explorer, tap File | Exit.  

 Receive Contact or File
1. Tap on the Bluetooth icon.  In the pop-up menu, tap Transfer via Bluetooth | Receive Contact or File.

2. The Receive Contact or File status screen will appear.  Your mobile computer will wait two minutes for the contact or file.

3. After successfully connecting to the remote device, the screen will report Connected then disappear.  The new contact or file 
should now be on your device.

4. If two minutes passes before you receive the item, tap Wait Again.

5. After you receive the file or contact, the "Receive Contact or File" feature is automatically disabled.
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Enable File Sharing
1. Tap on the Bluetooth icon.  In the pop-up menu, tap Transfer via Bluetooth | Enable File Sharing.

2. The Enable File Sharing status screen will appear.  Your mobile computer will wait two minutes for the remote device to 
connect.

3. After successfully connecting to the remote device, the screen will report Connected.

4. If two minutes passes before you connect, tap Wait Again.

5. File sharing will be enabled until you end it by tapping Cancel.

The Dialer
This section explains how to assign a dialing prefix and use the Dialer to dial a number directly from your Contacts list.  The Dialer 
makes it quick and easy to perform dial-up networking.

If you have not done so already, be sure to run the Dialer Installer from the Bluetooth Card Installation CD.  While installing the 
program, you can also assign the dialing prefix.

Note: The Dialer has been verified to work with Nokia and Ericsson phones and is known not to work with the Motorola 270c, 
NTT Docomo Paldio 633S or Sony au C413S phone.  Results may vary with other phones that are not listed as being supported 
by the Bluetooth system.

Assign a Dialing Prefix

If you have not already assigned a dialing prefix during the install process, you can do so by following these steps:

1. Go to Start | Settings | System.  Tap on Dialer.

2. Select the appropriate Dialing Prefix, then tap ok.
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Use the Dialer

1. To use the dialer, the mobile computer must already be connected to the Bluetooth phone.  You can use the Get Connected! 
Wizard to do this.  Also, the Bluetooth phone must be selected as your favorite.

2. Go to Start | Contacts.

3. Tap and hold your stylus on the contact you wish to dial to.  In the pop-up menu, select Dial Contact.  Alternatively, you can 
tap on Tools and select Dial Contact.

4. If you have multiple phone numbers for a contact, a screen will appear listing them, including any dialing prefix you may have 
assigned.  Select the phone number you wish to dial.

5. Your mobile computer will connect to your phone and begin dialing.

Note: The Dialer can dial a phone number containing any of the 17 following non-numeric characters:

* # + . / ! @ - \ space    A    B    C     D     T      P     W
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Additionally, the following string can be included in a phone number: 

                                                                           (',')

The Dialer can not dial a phone number containing non-numeric characters other than those listed above.

HHP recommends that you follow the standard Microsoft Outlook format for phone numbers.

Get Connected Wizard
The Get Connected! Wizard guides you through a one-time setup process that prepares the mobile computer and phone for 
Bluetooth connections.  The wizard varies depending on what phone you want to connect to.

Ericsson, Nokia 6210, NTT DoCoMo, Sony Phones 

1. Tap on the Bluetooth task tray icon.  In the pop-up menu, select Get Connected!

2. Follow the Bluetooth "Get Connected!" Wizard.  In the second screen, use the drop-down list to select your Bluetooth phone.  
The wizard will provide tailored instructions based on your selection.

3. Follow the next screen(s) to prepare your specific phone for Bluetooth connections.  You may need to do 1, 2 or all of the 
following steps:

a. Naming your Bluetooth phone

b. Setting your Bluetooth phone in Discoverable mode

c. Preparing your Bluetooth passkey.
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4. When the search is complete, a list of the discovered Bluetooth phones will appear.  Choose the phone you wish to connect 
to, and tap Select.  A service discovery phase will begin, about 5-10 seconds.

5. As prompted in the next screen, prepare your phone for bonding.  For instructions on setting your phone to "Bondable" or 
"Pairable" mode, refer to your phone manual.  Have your passkey ready, then tap Next>.

6. In the next screen, enter the passkey.  Tap Reply.

 

7. The mobile phone may then either automatically accept the passkey or ask you to enter one.  If prompted for a passkey, use 
the same one you entered on the mobile computer.

Ericsson T68/T68i only: When the phone asks you if you want to bond, select 2: Add to paired devices.  Do not tap ACCEPT.

8. Tap Finish.  After successfully connecting, the phone will appear in the Bluetooth Devices folder.  In the Today screen, the 
Bluetooth icon will also blink.  You will not need to run the Get Connected! Wizard again unless you plan to switch between 
different phones.
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Note: You may also switch between different phones by assigning a new "favorite phone" in the Bluetooth Devices folder.

Motorola Timeport 270C, Nokia 3650/6310/7650/8910/8910i 

1. Tap on the Bluetooth task tray icon  .  In the pop-up menu, select Get Connected!

2. Follow the Bluetooth "Get Connected!" Wizard.  In the second screen, use the drop-down list to select your Bluetooth phone.  
The wizard will provide tailored instructions for your phone.

Note: The screens below are for the Nokia 7650.

3. As directed in the next two screens, assign the phone a unique name and set the phone in Discoverable mode.  Then tap 
Next>.

4. The mobile computer will begin to search for the phone.  When the search is over, a list of the discovered Bluetooth phones 
will appear.

Choose the phone you wish to connect to, and tap Select.  A service discovery phase will begin, about 5-10 seconds.

5. The next two screens describe procedures you can only complete outside of the wizard.  Read through each screen but do 
not complete the described procedures until you exit the wizard.  Directions for these procedures are provided in STEP 7: 
Dial-up to Your Network, starting on the next page.  The two procedures are:

Bonding with your phone - This must be completed in order to complete the Bluetooth connection and involves dial-up 
networking.
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Automatic Connections - This procedure is optional but will make future Bluetooth connections more convenient.  

6. Continue to the last screen of the wizard and tap Finish.  Now proceed to STEP 6 to complete the bonding process and, if 
desired, set up automatic connections.

 

Dial-up to Your Network
Complete the following steps to create a new Bluetooth connection.  Before setting up dial-up networking, prepare yourself with 
dial-up information and other necessary settings for your office network or ISP.  

1. Go to Start | Settings | Connections.  Tap on the Connections icon.  In the top field, select Internet Settings.  Tap Modify… In 
the next screen, tap New…
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2. In the next screen, enter a name for the dial-up connection.  For the modem, select Bluetooth Phone.  For the Baud Rate, 
select 115200.  Tap Advanced…  

Note: Remember what you name the connection.  You will need it when you start the connection.

3. The Port Settings screen will appear.  If needed, tap on the TCP/IP and/or Name Servers screens to enter any necessary 
settings for your office network or ISP.  Tap ok.  

 

4. Tap Next.

5. In the Phone number field, enter the dial-up number.  Tap Next.

6. Uncheck Wait for dial tone before dialing.  Tap Finish.

7. Now you are ready to start the connection.  In the Connections screen, under Internet Settings, tap Connect.  In Network Log 
On, verify the dialing settings.  Tap OK.
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8. ONLY FOR MOTOROLA TIMEPORT 270C OR NOKIA 3650/6310/7650/8910/8910i: 

a) After you tap Connect for the first time, the phone will display a message asking if you want to bond.  On Motorola, enter 
GRANT; on Nokia, enter ACCEPT.  

b) Make up a 4-16 digit passkey, enter it on the phone, then enter it on the Pocket PC.

Note: The Bluetooth icon on the Today screen will blink to indicate a connection.

c) After successfully bonding, you can set up the phone to automatically connect to your Dolphin 9500/9550 without requiring 
a passkey.

Automatic Connections for Motorola Timeport 270C:

• On the phone, press MENU.
• Scroll to Settings, then press SELECT.
• Scroll to Connection, then press ON.
• On Bluetooth Link, press SELECT.
• Scroll to Devices, then press SELECT.
• Choose your mobile computer, then press EDIT.
• Scroll to Access:Ask, then press CHANGE.
• Scroll to Automatic, then press SELECT.  Press DONE.

Automatic Connections for Nokia 3650/7650:

• On the phone, press MENU.
• Scroll to Connectivity, then press Options.
• The Open option should be highlighted.  Press Select.
• The Bluetooth option should be highlighted.  Press Options.
• The Open option should be highlighted.  Press Select.
• Scroll to the right tab to access the Paired devices list.  Highlight your mobile computer, then press Options.
• Scroll to Set as authorized, then press Select.
• In the confirmation screen, press Yes.

Automatic Connections for Nokia 6310/8910/8910i:

• On the phone, press MENU.
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• Scroll to 10 Bluetooth, then press SELECT.
• Scroll to 4 View Paired Devices, then press SELECT.
• Highlight the Pocket PC, then press OPTIONS.
• Scroll to 3 Request Connection Authorization, then press NO.
9. To use a different Bluetooth phone for dial-up networking, you can use the same connection setup, but you must make the 

new phone your favorite.  Just run the Get Connected! Wizard again, select the new phone, and make it your new Favorite 
when prompted.  

Alternatively, you can use the Bluetooth Devices folder to change your favorite phone.  Refer to  for instructions.
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6

Do
Customizing Your Dolphin 9500/9550
You can customize your Dolphin 9500/9550 mobile by adjusting device settings and installing additional software.

Adjusting Settings

You can adjust device settings to suit the way you work.  To see available options, tap Start, Settings, then the Personal or 
System tab located at the bottom of the screen.

You might want to adjust the following:

• Clock, to change the time or to set alarms
• Menus, to customize what appears on the Start menu, and to enable a pop-up menu from the New button
• Owner Information, to enter your contact information
• Password, to limit access to your device
• Power, to maximize battery life
• Today, to customize the look and the information that is displayed on the Today screen

Adding Programs

Programs added to your device at the factory are stored in ROM (read-only memory).  You cannot remove this software, and 
you’ll never accidentally lose ROM contents.  ROM programs can be updated using special installation programs with a *.xip 
extension.  All other programs and data files added to your device after factory installation are stored in RAM (random access 
memory).  

You can install any program created for your device, as long as your device has enough memory.  The most popular place to 
find software for your device is on the Pocket PC Web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync
You’ll need to install the appropriate software for your device on your desktop computer before installing it on your device.

1. Determine your device and processor type so that you know which version of the software to install.  Tap Start and then 
Settings.  On the System tab, tap About.  In the Version tab, make a note of the information in Processor.  

2. Download the program to your desktop computer (or insert the CD or disk that contains the program into your desktop 
computer).  You may see a single *.xip,  *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device 
types and processors.  Be sure to select the program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the program.  Many programs provide 
special installation instructions.

4. Connect your device and desktop computer.

5. Double-click the *.exe file.

If the file is an installer, the installation wizard will begin.  Follow the directions on the screen.  Once the software has been 
installed on your desktop computer, the installer will automatically transfer the software to your device.  

If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a different type 
of computer.  You will need to move this file to your device.  If you cannot find any installation instructions for the program in the 
Read Me file or documentation, use ActiveSync Explore to copy the program file to the Program Files folder on your device.  For 
more information on copying files using ActiveSync, see ActiveSync Help.  

Once installation is complete, tap Start, Programs, and then the program icon to switch to it.

To add a program directly from the Internet
1. Determine your device and processor type so that you know which version of the software to install.  Tap Start  and then 

Settings.  On the System tab, tap About.  In the Version tab, make a note of the information in Processor.  

2. Download the program to your device straight from the Internet using Pocket Internet Explorer.  You may see a single *.xip,  
*.exe or *.zip file, a Setup.exe file, or several versions of files for different device types and processors.  Be sure to select the 
program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the program.  Many programs provide 
special installation instructions.
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4. Tap the file, such as a *.xip or *.exe file.  The installation wizard will begin.  Follow the directions on the screen.

Adding a Program to the Start Menu
Tap Start, Settings, Menus, the Start Menu tab, and then the check box for the program.  If you do not see the program listed, 
you can either use File Explorer on the device to move the program to the Start Menu folder, or use ActiveSync on the desktop 
computer to create a shortcut to the program and place the shortcut in the Start Menu folder.

Using File Explorer on the Dolphin 9500/9550

1. Tap Start, Programs, File Explorer, and locate the program (tap the folder list, labeled My Documents by default, and then 
My Device to see a list of all folders on the device).  

2. Tap and hold the program and tap Cut on the pop-up menu.  

3. Open the Start Menu folder located in the Windows folder, tap and hold a blank area of the window, and tap Paste on the 
pop-up menu.  

4. The program will now appear on the Start menu.

For more information on using File Explorer, see “Find and Organize Information,” on page.

Using ActiveSync on the desktop computer: Use the Explorer in ActiveSync to explore your device files and locate the 
program.  Right-click the program, and then click Create Shortcut.  Move the shortcut to the Start Menu folder in the Windows 
folder.  The shortcut now appears on the Start menu.  For more information, see ActiveSync Help.

Removing Programs
Tap Start and then Settings.  On the System tab, tap Remove Programs.

If the program does not appear in the list of installed programs, use File Explorer on your device to locate the program, tap and 
hold the program, and then tap Delete on the pop-up menu.
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7

Do
Applications
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes.  You can use these programs individually or 
together.  For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox.  

Using ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your desktop computer with 
your device.  You can also synchronize this information directly with a Microsoft Exchange server.  Each time you synchronize, 
ActiveSync compares the changes you made on your device and desktop computer or server and updates both computers with 
the latest information.  For information on using ActiveSync, see ActiveSync Help on the desktop computer.

You can switch to any of these programs by tapping them on the Start menu.

Calendar: Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events.  You can check your appointments in one of 
several views (Agenda, Day, Week, Month, and Year) and easily switch views by using the View menu.

Note: You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the Tools 
menu.  

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.

Calendar Application
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To create an appointment:

1. If you are in Day or Week view, tap the desired date and time for the appointment.

2. Tap New.

3. Using the input panel, enter a description and a location.  Tap first to select the field.  

4. If needed, tap the date and time to change them.

5. Enter other desired information.  You will need to hide the input panel to see all available fields.

6. To add notes, tap the Notes tab.  You can enter text, draw, or create a recording.  For more information on creating notes, 
refer to Notes on page 7-10.

7. When finished, tap OK to return to the calendar.  

Note: If you select Remind me in an appointment, your device will remind you according to the options set in Start, Settings, 
Personal tab, Sounds & Reminders.  

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.

Entering an Appointment
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed.  To change the appointment, tap Edit.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook.  The meeting request will be created 
automatically and sent either when you synchronize Inbox or when you connect to your e-mail server.  Indicate how you want 
meeting requests sent by tapping Tools and then Options.  If you send and receive e-mail messages through ActiveSync, select 
ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, and then tap Attendees.

3. From the list of e-mail addresses you’ve entered in Contacts, select the meeting attendees.  

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and Inbox Help on the device.

View appointment details.

View.

Tap to change
appointment.

Appointment Summary Screen
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Contacts

Contacts maintains a list of your friends and colleagues so that you can easily find the information you’re looking for, whether 
you’re at home or on the road.  Using the device infrared (IR) port, you can quickly share Contacts information with other device 
users.

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap and enter part of a name to
quickly find it in the list.

Tap to display or edit
the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to see additional phone
numbers and e-mail addresses.

Tap to create a new contact.

Select the category of contacts
you want displayed in the list.

Contact Application
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To create a contact:

1. Tap New.

2. Using the input panel, enter a name and other contact information.  You will need to scroll down to see all available fields.

3. To assign the contact to a category, scroll to and tap Categories and select a category from the list.  In the contact list, you 
can display contacts by category.

4. To add notes, tap the Notes tab.  You can enter text, draw, or create a recording.  For more information on creating notes, 
refer to Notes on page 7-10.

5. When finished, tap OK to return to the contact list.

There are four ways to find a contact: 

• In the contact list, enter a contact name in the box under the navigation bar.  To show all contacts again, clear text from the 
box or tap the button to the right of the box.  

• In the contact list, tap the category list (labeled All Contacts by default) and select the type of contact that you want displayed.  
To show all contacts again, select All Contacts.  To view a contact not assigned to a category, select None.  

• To view the names of companies your contacts work for, in the contact list, tap View > By Company.  The number of contacts 
that work for that company will be displayed to the right of the company name.  

• Tap , Find, enter the contact name, select Contacts for the type, and then tap Go.  

Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.  To change the contact information, tap Edit.

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.

Creating a Contact
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View contact details.

Tap to view notes.

Tap to change contact information.

Contacts Summary Screen
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Tasks

Use Tasks to keep track of what you have to do.  

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

Task Application
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To create a task:

1. Tap New.

2. Using the input panel, enter a description.

3. You can enter a start date and due date or enter other information by first tapping the field.  If the input panel is open, you will 
need to hide it to see all available fields.

4. To assign the task to a category, tap Categories and select a category from the list.  In the task list, you can display tasks by 
category.

5. To add notes, tap the Notes tab.  You can enter text, draw, or create a recording.  For more information on creating notes, 
refer to Notes on page 7-10.

6. When finished, tap OK to return to the task list.

Note: To quickly create a task with only a subject, tap Entry Bar on the Tools menu.  Then, tap Tap here to add a new task 
and enter your task information.

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

Creating a Task
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Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed.  To change the task, tap Edit.

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.

Task Summary Screen
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Notes

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes.  You can create a written note or a 
recording.  You can also include a recording in a note.  If a note is open when you create the recording, it will be included in the 
note as an icon.  If the note list is displayed, it will be created as a stand-alone recording.

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.

Notes Application
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To create a note:

1. Tap New.

2. Create your note by writing, drawing, typing, and recording.  For more information about using the input panel, writing and 
drawing on the screen, and creating recordings, see Chapter xx.

Inbox

Use Inbox to send and receive e-mail messages in either of these ways: 

• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a 

network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process.  You will need to enable Inbox 
synchronization in ActiveSync.  For information on enabling Inbox synchronization, see ActiveSync Help on the desktop 
computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the ActiveSync folder in Inbox 
on your device.  By default, you will receive messages from the past three days only, the first 100 lines of each message, and 
file attachments of less than 100 KB in size.

Tap to return to the note
list (the note is saved
automatically).

Tap to write on the screen.

Tap to show or hide
the input panel.

Tap to add a recording
to the note.

Creating a Note
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• E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, and then sent from those 
programs.

• E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in order to be transferred.

Note: You can also synchronize e-mail messages with your desktop computer from a remote location.  For more information, 
see Chapter 7.

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by 
connecting to an e-mail server.

When you connect to the e-mail server, new messages are downloaded to the device Inbox folder, messages in the device 
Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer.  
When you delete a message on your device, it is also deleted from the e-mail server the next time you connect based on the 
settings you selected in ActiveSync.

You can work online or offline.  When working online, you read and respond to messages while connected to the e-mail server.  
Messages are sent as soon as you tap Send, which saves space on your device.

When working offline, once you’ve downloaded new message headers or partial messages, you can disconnect from the e-mail 
server and then decide which messages to download completely.  The next time you connect, Inbox downloads the complete 
messages you’ve marked for retrieval and sends the messages you’ve composed.
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Using the Message List
Messages you receive are displayed in the message list.  By default, the most recently received messages are displayed first in 
the list.

When you receive a message, tap it to open it.  Unread messages are displayed in bold.

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.

InBox Application
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When you connect to your e-mail server or synchronize with your desktop computer, by default, you’ll receive messages from 
the last five days only, the first 100 lines of each new message, and file attachments of less than 100 KB in size.  The original 
messages remain on the e-mail server or your desktop computer.  

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection.  In the 
message list, tap and hold the message you want to retrieve.  On the pop-up menu, tap Mark for Download.  The icons in the 
Inbox message list give you visual indications of message status.

You specify your downloading preferences when you set up the service or select your synchronization options.  You can change 
them at any time:

• Change options for Inbox synchronization using ActiveSync options.  For more information, see ActiveSync Help.
• Change options for direct e-mail server connections in Inbox on your device.  Tap Tools and then tap Options.  On the 

Service tab, tap the service you want to change.  Tap and hold the service and select Delete to remove a service.

Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.

Viewing A Message
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Composing Messages

To compose a message:

1. Tap New.  

2. In the To field, enter an e-mail or SMS address of one or more recipients, separating them with a semicolon, or select a 
name from the contact list by tapping the Address Book button.  
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

• Compose your message.  To enter preset or frequently used messages, tap My Text and select a message.
• Tap Send when you’ve finished the message.  If you are working offline, the message is moved to the Outbox folder and will 

be sent the next time you connect.

If you are sending an SMS message and want to know if it was received, tap Edit, Options, and select Request SMS text 
message delivery notification before sending the message.

Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.

Creating a Message
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Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, Outbox, 
and Sent Items.  The Deleted Items folder contains messages that have been deleted on the device.  The behavior of the Deleted 
and Sent Items folders depends on the options you have chosen.  In the message list, tap Tools and then Options.  On the 
Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and then Manage Folders to create new folders.  To move 
a message to another folder, in the message list, tap and hold the message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4.  

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your device.  
You can select to synchronize additional folders by designating them for ActiveSync.  The folders you create and the 
messages you move will then be mirrored on the server.  For example, if you move two messages from the Inbox folder to a 
folder named Family, and you have designated Family for synchronization, the server creates a copy of the Family folder and 
copies the messages into that folder.  You can then read the messages while away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder.  
• If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the 

device and their copies on the mail server.  The next time you connect, the mail server will see that the messages are missing 
from the device Inbox and delete them from the server.  This prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages that you move to folders created from anywhere except the 
device.  

• If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on the server.  Therefore, messages 
are available to you anytime you connect to your mail server, whether it is from your device or desktop computer.  This 
synchronization of folders occurs whenever you connect to your mail server, create new folders, or rename/delete folders 
when connected.  
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Do
Communications
Using Microsoft ActiveSync, you can synchronize the information on your desktop computer with the information on your 
device.  Synchronization compares the data on your Dolphin mobile computer with your desktop computer and updates both 
computers with the most recent information.  For example:

• Keep Pocket Outlook data up-to-date by synchronizing your device with Microsoft Outlook data on your desktop computer.  
• Synchronize Microsoft Word and Microsoft Excel files between your device and desktop computer.  Your files are 

automatically converted to the correct format

Note: By default, ActiveSync does not automatically synchronize all types of information.  Use ActiveSync options to turn 
synchronization on and off for specific information types.

With ActiveSync, you can also:

• Back up and restore your device data.  
• Copy (rather than synchronize) files between your device and desktop computer.  
• Control when synchronization occurs by selecting a synchronization mode.  For example, you can synchronize continually 

while connected to your desktop computer or only when you choose the synchronize command.
• Select which information types are synchronized and control how much data is synchronized.  For example, you can choose 

how many weeks of past appointments you want synchronized.

Before you begin synchronization, install ActiveSync on your desktop computer from the Pocket PC Companion CD.  ActiveSync 
is already installed on your device.  

To install ActiveSync on your desktop computer, insert the Pocket PC Companion CD into the CD-ROM drive of your desktop 
computer.  Click the yellow arrow, click Start Here, and then follow the directions on your screen.

After installation is complete, the ActiveSync Setup Wizard helps you connect your device to your desktop computer, set up a 
partnership so you can synchronize information between your device and your desktop computer, and customize your 
synchronization settings.  Your first synchronization process will automatically begin when you finish using the wizard.  
ActiveSync is already installed on your device.

After installation is complete, the ActiveSync Setup Wizard helps you connect your device to your desktop computer, set up a 
partnership so you can synchronize information between your device and your desktop computer, and customize your 
synchronization settings.  Your first synchronization process will automatically begin when you finish using the wizard.  

After your first synchronization, take a look at Calendar, Contacts, and Tasks on your device.  You’ll notice that information you’ve 
stored in Microsoft Outlook on your desktop computer has been copied to your device, and you didn’t have to type a word.  
Disconnect your device from your computer and you’re ready to go!

Once you have set up ActiveSync and completed the first synchronization process, you can initiate synchronization from your 
device.  

To switch to ActiveSync on your device, tap Start, and then tap ActiveSync.  Note that if you have a wireless LAN card, you can 
synchronize remotely from your device.

For information about using ActiveSync on your desktop computer, start ActiveSync on your desktop computer, and then see 
ActiveSync Help.
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For more information about ActiveSync on your device, switch to ActiveSync, tap Start, and then tap Help.

Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.

ActiveSync
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Getting Connected
You can use your device to exchange information with other mobile devices as well as your desktop computer, a network, or the 
Internet.  You have the following connection options:

• Use the infrared (IR) port on your device to send and receive files between two devices.  If this is the method you want to use, 
see the following section “Transfer Items Using Infrared.”

• Connect to your Internet service provider (ISP).  Once connected, you can send and receive e-mail messages by using Inbox 
and view Web or WAP pages by using Microsoft Pocket Internet Explorer.  The communication software for creating an ISP 
connection is already installed on your device.  Your service provider will provide software needed to install other services, 
such as paging and fax services.

• Connect to your desktop computer to synchronize remotely.  Once connected, you can synchronize information such as your 
Pocket Outlook information.  If this is the method you want to use, see ActiveSync Help on your desktop computer or 
Connections Help on the device.

Transfer Items Using Infrared

Using infrared (IR), you can send and receive information, such as contacts and appointments, between two Windows-equipped 
devices.

To send information:

1. Open the program where you created the item you want to send and locate the item in the list.

2. Align the IR ports so that they are unobstructed and within a close range.

3. Tap and hold the item, and tap Beam Item on the pop-up menu.

Note: You can also send items, but not folders, from File Explorer.  Tap and hold the item you want to send, and then tap Beam 
File on the pop-up menu.

To receive information:

1. Align the IR ports so that they are unobstructed and within a close range.

2. Have the owner of the other device send the information to you.  Your device will automatically receive it.

Note: For IR receive to work automatically, you must first check th Receive all incoming beams and select discoverable mode 
checkbox in Start>Settings>Connections>Beam.  If this box is not checked, select Start>Programs>Infrared Receive 
before receiving data from another device.

Get Help on Connecting

More information on the procedures described here, as well as information on additional procedures, can be found in the following 
locations:

• “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.
• Online Help on the device.  Tap Start and then Help.  Tap View, All Installed Help, and then Inbox or Connections.
• ActiveSync Help on the desktop computer.  In ActiveSync, click Microsoft ActiveSync Help on the Help menu.

For troubleshooting information, go to the Pocket PC Web site at: http://www.microsoft.com/mobile/pocketpc
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Pocket Internet Explorer 
Use Microsoft Pocket Internet Explorer to view Web or WAP pages in either of these ways:

• During synchronization with your desktop computer, download your favorite links and mobile favorites that are stored in the 
Mobile Favorites subfolder in Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the Web.  

When connected to an ISP or network, you can also download files and programs from the Internet or intranet.

To switch to Pocket Internet Explorer, tap Start and then Internet Explorer.

The Mobile Favorites Folder

Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet Explorer on your desktop computer will be 
synchronized with your device.  This folder was created automatically when you installed ActiveSync.  

Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites folder on your desktop computer is synchronized with 
Pocket Internet Explorer on your device.  Both computers are updated with changes made to either list each time you 
synchronize.  Unless you mark the favorite link as a mobile favorite, only the link will be downloaded to your device, and you will 
need to connect to your ISP or network to view the content.  For more information on synchronization, see ActiveSync Help on 
the desktop computer.

Mobile Favorites 
If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can download mobile favorites to your 
device.  Synchronizing mobile favorites downloads Web content to your device so that you can view pages while you are 
disconnected from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites:

1. In Internet Explorer on your desktop computer, click Tools and then Create Mobile Favorite.

2. To change the link name, enter a new name in the Name box.  

3. Optionally, in Update, select a desired update schedule.

4. Click OK.  Internet Explorer downloads the latest version of the page to your desktop computer.

5. If you want to download the pages that are linked to the mobile favorite you just created, in Internet Explorer on the desktop 
computer, right-click the mobile favorite and then click Properties.  In the Download tab, specify the number of links deep 
you want to download.  To conserve device memory, go only one level deep.

6. Synchronize your device and desktop computer.  Mobile favorites that are stored in the Mobile Favorites folder in Internet 
Explorer are downloaded to your device.

If you did not specify an update schedule in step 3, you will need to manually download content to keep the information updated 
on your desktop computer and device.  Before synchronizing with your device, in Internet Explorer on your desktop computer, 
click Tools and then Synchronize.  You will see the last time content was downloaded to the desktop computer, and you can 
manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites.  In Internet Explorer on your desktop computer, 
click View, Toolbars, and then Customize.

Saving Memory on you Dolphin Mobile Computer
Mobile favorites take up storage memory on your device.  To minimize the amount of memory used:

• In the settings for the Favorites information type in ActiveSync options, turn off pictures and sounds, or stop some mobile 
favorites from being downloaded to the device.  For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages.  In Internet Explorer on the desktop computer, right-click the mobile favorite 
you want to change and then Properties.  In the Download tab, specify 0 or 1 for the number of linked pages you want to 
download.
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Using AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites.  You 
subscribe to AvantGo channels directly from your device.  Then, you synchronize your device and desktop computer, or connect 
to the Internet to download the content.  For more information, visit the AvantGo Web site.

To sign up for AvantGo: 

1. In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo information type.

2. In Pocket Internet Explorer on your device, tap the Favorites button to display your list of favorites.

3. Tap the AvantGo Channels link.

4. Tap the Activate button.

5. Follow the directions on the screen.  You will need to synchronize your device with your desktop computer and then tap the 
My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a few of the most popular 
channels.  To add or remove channels, tap the Add or Remove link.

Using Pocket Internet Explorer

You can use Pocket Internet Explorer to browse mobile favorites and channels that have been downloaded to your device without 
connecting to the Internet.  You can also connect to the Internet through an ISP or a network connection and browse the Web.

Pocket Internet Explorer
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To view mobile favorites and channels:

1. Tap the Favorites button to display your list of favorites.  

2. Tap the page you want to view.  

You’ll see the page that was downloaded the last time you synchronized with your desktop computer.  If the page is not on your 
device, the favorite will be dimmed.  You will need to synchronize with your desktop computer again to download the page to 
your device, or connect to the Internet to view the page.

To browse the Internet:

1. Set up a connection to your ISP or corporate network using Connections, as described in Chapter 9.

2. To connect and start browsing, do one of the following:

• Tap the Favorites button, and then tap the favorite you want to view.
• Tap View and then Address Bar.  In the address bar that appears at the top of the screen, enter the Web address you want 

to visit and then tap Go.  Tap the arrow to choose from previously entered addresses.

Note: If you select Pocket Internet Explorer before setting up the network connections, a screen may appear allowing you to 
proceed to the connection settings screen.  After you select the settings, you return to Pocket Internet Explorer.  To add 
a favorite link while using the device, go to the page you want to add, tap and hold on the page, and tap Add to Favorites.

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.

Mobile Favorites
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Companion Programs
The companion programs consist of Microsoft Pocket Word and Microsoft Pocket Excel.  

To switch to a companion program on your device, tap Programs on the Start menu, and then tap the program name.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to give you easy access to copies of your documents.  You 
can create new documents on your device, or you can copy documents from your desktop computer to your device.  Synchronize 
documents between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports.  To create a new file, tap Start> 
Programs>Pocket Word>New.  A blank document appears.  Or, if you’ve selected a template for new documents in the Options 
dialog box, that template appears with appropriate text and formatting already provided.  You can open only one document at a 
time; when you open a second document, you’ll be asked to save the first.  You can save a document you create or edit in a 
variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).  

Pocket Word contains a list of the files stored on your device.  Tap a file in the list to open it.  To delete, make copies of, and send 
files, tap and hold a file in the list.  Then, select the appropriate action on the pop-up menu.

You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and recording), which are displayed on 
the View menu.  Each mode has its own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button on the 
command bar.

You can change the zoom magnification by tapping View and then Zoom.  Then select the percentage you want.  Select a higher 
percentage to enter text and a lower one to see more of your document.

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.

Select the type of folder you
want displayed in the list.

Using Pocket Word
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If you’re opening a Word document created on a desktop computer, select Wrap to Window on the View menu so that you can 
see the entire document.

Typing Mode
Using the input panel, enter typed text into the document.  For more information on entering typed text, refer to Using the Dolphin 
9500/9550 Mobile Computer.

To format existing text and to edit text, first select the text.  You can select text as you do in a Word document, using your stylus 
instead of the mouse to drag through the text you want to select.  You can search a document to find text by tapping Edit and 
then Find/Replace.

Tap to change
formatting options.

Tap to format text.

Tap and hold to see a
pop-up menu of actions.

Tap to show or hide
the toolbar.

Tap to return to the
document list (changes are
saved automatically).

Formatting Text 
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Writing Mode
In writing mode, use your stylus to write directly on the screen.  Ruled lines are displayed as a guide, and the zoom magnification 
is greater than in typing mode to allow you to write more easily.  For more information on writing and selecting writing, see Chapter 
xx.

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be edited and manipulated as 
described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a Word document on your 
desktop computer.

Drawing Mode

In drawing mode, use your stylus to draw on the screen.  Gridlines appear as a guide.  When you lift your stylus off the screen 
after the first stroke, you’ll see a drawing box indicating the boundaries of the drawing.  Every subsequent stroke within or 
touching the drawing box becomes part of the drawing.  For more information on drawing and selecting drawings, see Chapter xx.

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.

Space button.

Tap to select formatting options,
such as pen weight and line color.

Pen button.

Writing on the Screen in Pocket Word
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For more information on using Pocket Word, tap Start and then Help.

Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks.  You 
can create new workbooks on your device, or you can copy workbooks from your desktop computer to your device.  Synchronize 
workbooks between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs.  To create a new file, tap Start, Programs, 
Pocket Excel, and then New.  A blank workbook appears.  Or, if you’ve selected a template for new workbooks in the Options 
dialog box, that template appears with appropriate text and formatting already provided.  You can open only one workbook at a 
time; when you open a second workbook, you’ll be asked to save the first.  You can save a workbook you create or edit in a 
variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your device.  Tap a file in the list to open it.  To delete, make copies of, and 
send files, tap and hold a file in the list.  Then select the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering.  To display the toolbar, 
tap View and then Toolbar.  

Select Shape on the
pop-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow  to
see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

Pen button.

Drawing on the Screen in Pocket Word
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If your workbook contains sensitive information, you can protect it with a password.  To do so, open the workbook, tap Edit, and 
then Password.  Every time you open the workbook, you will need to enter the password, so choose one that is easy for you to 
remember but hard for others to guess.

Tips for Working in Pocket Excel

When working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible.  Tap View and then Full Screen.  To exit full-screen 
mode, tap Restore.

• Show and hide window elements.  Tap View and then tap the elements you want to show or hide.
• Freeze panes on a worksheet.  First select the cell where you want to freeze panes.  Tap View and then Freeze Panes.  You 

might want to freeze the top and leftmost panes in a worksheet to keep row and column labels visible as you scroll through a 
sheet.

• Split panes to view different areas of a large worksheet.  Tap View and then Split.  Then drag the split bar to where you want 
it.  To remove the split, tap View and then Remove Split.

• Show and hide rows and columns.  To hide a hidden row or column, select a cell in the row or column you want to hide.  Then 
tap Format, then Row or Column, and then Hide.  To show a hidden row or column, tap Tools, then Go To, and then type 
a reference that is in the hidden row or column.  Then tap Format, then Row or Column, and then Unhide.

For more information on using Pocket Excel, tap Start and then Help.

Media Player, Microsoft ® Money, MSN Messenger, Microsoft Reader are NOT included on the Dolphin 9500/9550 but maybe 
installed from the Microsoft Companion CD.

Cell contents appear here
as you enter them.

AutoSum button.

Format button.

Zoom button.

Using Pocket Excel
Dolphin® 9500/9550 Mobile Computer User’s Guide 11 - 5



11 - 6 Dolphin® 9500/9550 Mobile Computer User’s Guide



12
Do
Dolphin 9500/9550 HomeBase™
Hub of the System

As the hub of your Dolphin 9500/9550 system, the Dolphin 9500/9550 Charging/Communication cradle performs three important 
functions – power, communications and storage.  

Power Conditioning
The HomeBase provide power to the intelligent battery charging system incorporated into Dolphin terminals.

The charging/communication cradle also has an auxiliary battery well, located on the back of the cradle, allowing users to charge 
a spare battery.

Communications

Reliable data communications at speeds of up to 115k baud can be transmitted by the HomeBase through the RS-232 serial 
port.; data transmission rates with the full-speed USB port up to 2 Mbps are possible.  

The HomeBase cannot be “daisy-chained” but can be networked together using a serial or USB hub.

Convenient Storage 
Dolphin charging/communication peripherals provide a safe and convenient storage receptacle for your Dolphin terminal.  
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Dolphin 9500/9550 HomeBase Charging/Communication Cradle Parts & Functions

Front Panel

HomeBase 

Battery 
Well

Battery 

Image Engine/
Laser Engine 
Window 

Stylus

Speaker

Microphone
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Terminal Well  Place the Dolphin in this well to communicate with a host device and to charge the Dolphin’s battery.

LEDs  There are three LEDs on the front panel of the HomeBase.

1. Dock LED   Turns solid green when the Dolphin terminal is properly seated into the Dolphin HomeBase.

2. AUX BATT LED  Indicates status of battery charging in the HomeBase’s auxiliary well.

Front View of HomeBase

AUX BATT  LED Description

Orange LED AUX battery is charging.  
Green LED AUX battery is charged and ready for use.

DOCK LED
COMM LED

Terminal Well
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3. COMM LED   Indicates the status of data transfer between the Host Device and the Dolphin Terminal as described below.

:Using the Serial Port:

Using the USB Port:

Comm LED Description

Red LED Serial data is being sent from the Host Device to 
the Dolphin HomeBase.  

Green LED Serial data is being sent from the Dolphin 
HomeBase to the Host Device.

Orange LED Serial data is being sent at high data rates.

Comm LED Description

Green LED A USB Connection is established with the host 
computer.
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Back Panel

HomeBase

Power supply connector  Use this connector to attach a power supply to the HomeBase.  The power supply provides 9.5V DC 
input for communications and battery charging.

RS-232 Communications Port  Use a standard serial cable to connect this port to a host RS-232 device.  

USB Communications Port  Use a USB full-speed detachable cable to connect this downstream device port to an upstream 
USB Host or Hub.  The USB HomeBase is USB 1.1 compliant.

Auxiliary Battery Well  Insert a battery into the well to charge a battery pack.

Rear View of Dolphin 9500/9550 HomeBase

Power Supply 
Connector

RS-232 
Connector

Auxiliary 
Battery Well

Condition Button
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Powering the Dolphin Terminal

The HomeBase charging/communication cradle provides power to the intelligent battery charging system incorporated into 
Dolphin 9500/9550 terminals.  This charging method protects the battery from being damaged by overcharging.  Therefore, 
Dolphin terminals may be stored indefinitely in the charging/communication cradles without damage to the terminals, battery 
packs, or peripherals.

To charge a Dolphin terminal, follow these steps:

1. Insert a battery pack into the Dolphin terminal.

2. Place the terminal, imager window up and the LCD visible, in the terminal well of the cradle.  

3. Let it glide down into the well until it stops.  

4. Once the Dolphin terminal is properly seated, the Dock LED on the front of the cradle will be solid GREEN.

Charging Additional Battery Packs in the HomeBase
The auxiliary battery well located on the back of the HomeBase allows users to charge a spare battery.  Charging a Dolphin 
terminal and a spare battery pack can be done simultaneously as the charging slots work independently to control the charging 
of the individual batteries.  The HomeBase senses when a battery pack is fully charged and automatically switches  to maintain 
the battery at full capacity indefinitely.

To charge a spare battery in the Aux Well, insert the end of the battery without the locking tab into the bottom of the auxiliary well 
opening and snap the battery into place with a hinging motion.  Once the battery is inserted, you can use the AUX BATTERY 
LED to monitor the charging progress.  

Setting Up For Communications

The HomeBase supports RS-232 communications through the RS-232 Communications Port located on the back of the 
device.The HomeBase interfaces the RS-232 signals from the host computer to the RS-232 signals of the Dolphin 9500/9550 
mobile computer.  

The HomeBase’s RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any RS-232 
device using a standard serial cable and communications software.

The HomeBase also supports USB communications through the USB port located on the back.  The HomeBase acts as a USB 
device, and interfaces the USB signals of the Dolphin 9500/9550 to the USB of the host computer.  Using a standard USB cable, 
the HomeBase’s USB interface allows the Dolphin terminal to communicate with a personal computer or to be networked through 
a USB hub.

Note: The HomeBase should have only one type of interface cable connected at a time, either USB or RS-232.

Installing The Charging/Communication Cradle Using the RS-232 Interface
To install and use the HomeBase, you need the following equipment:

• HomeBase with power supply
• Serial cable

Set the Dolphin HomeBase on a dry, stable surface, such as a desktop near an electrical outlet.  Be sure to provide enough 
workspace with good lighting for the user to view and operate the Dolphin terminal while it is in the HomeBase.

Connecting the Cables

Connect the HomeBase to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the rear of the HomeBase.  The wiring of your cable depends on whether the other device is set up as 
a DCE (Data Communications Equipment) or DTE (Data Terminal Equipment) device.  

The HomeBase Communication Port is configured as a DCE device.  To communicate with a DTE device such as a computer, 
use a standard (or straight-through) RS-232 cable.  To communicate with a DCE device, use either a null modem adapter in line 
with a standard RS-232 cable, or a null-modem serial cable.  

You can make your own cables by following the pin configuration in the chart below.  To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.
12 - 6 Dolphin® 9500/9550 Mobile Computer User’s Guide



Note: The HomeBase cannot be daisy-chained.

Connect the power supply to the charging/communication cradle.  Plug the AC transformer into the Dolphin HomeBase 9.5 Volt 
DC power supply connector.  The AC wall transformer provided can power only one HomeBase.  HHP recommends that you 
leave the Dolphin HomeBase connected to its power source at all times, so that it is always ready to use.

Configuring the Dolphin Terminal for Communications
The Dolphin terminal may be configured for communications using the Detectoid Communication Utility as described in Chapter 
2 or, manually as described below.

To set Communications Properties:

1. Select Start>ActiveSync>Tools>Options.  

2. Select the PC Connection tab.

HomeBase /Host 
Port (DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4

Communications Properties
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3. Select  the desired option for connecting to the desktop computer (‘115200’ default).  Click OK.

4. Place the Dolphin in the cradle.

5. The Dolphin 9500/9550 will automatically attempt to start an ActiveSync connection with the desktop computer,

Note: ActiveSync must be installed and configured properly on the desktop computer in order for an ActiveSync communication 
connection to the Dolphin 9500/9550 to be successful.

To configure the Dolphin 9500/9550 terminal for communications, see  Configuring the Dolphin Terminal for Communications on 
page 12-7.  

Installing the Charging/Communication Cradle Using the USB Interface

To use the USB HomeBase, you need the following equipment:

• HomeBase with power supply
• USB Cable
• CD with USB drivers
• Windows® 98, Windows® Me, Windows® 2000, or Windows® XP computer.

Note: The USB HomeBase does not support Windows NT®  

To install the HomeBase, follow these steps:

1. Plug in the power supply and connect it to the back of the HomeBase.  

2. Plug the USB cable into the back of the HomeBase.

3. Plug the other end of the USB cable into your PC.

At this point, a dialog box appears on your PC instructing you that the system has detected new hardware and it is searching for 
the HHP USB-IrDA driver.  Unless you have previously installed the USB HomeBase, the OS will be unable to find one and the 
Found New Hardware Wizard screen shown below will display on your PC’s screen.  

Desk top Computer ActiveSync Connection Settings
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In the "Locate Drive Files" dialog, check the CD-ROM drives check box and insert the driver CD provided into the CD tray on 
your PC.  Select the wceusbsh.inf file.

At this point, the hardware is installed and operating.  You may need to reset your PC to complete the installation process.  You 
may also need to remove and then re-insert the Dolphin 9500/9550 in the HomeBase to initiate a USB connection.  You can verify 
that the USB driver is functioning by watching the COMM LED on the USB home base.  It should be solid green.  

Once the USB HomeBase is installed, you can use ActiveSync to connect to a Dolphin 9500/9550.  These instructions assume 
that ActiveSync v3.1 is installed on your PC.  The latest version of ActiveSync can be downloaded from www.microsoft.com.

In the ActiveSync connection settings, add check mark "Allow USB connection with this desktop computer".  Do not  check “Allow 
serial cable or infrared connection to this COM port.
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To configure the Dolphin 9500/9550 terminal for communications, see Configuring the Dolphin Terminal for 
Communications on page 12-7.  

Communicating with the Dolphin 9500/9550 Terminal

To communicate with the Dolphin and any other devices connected to the Dolphin Charging/Communication cradle:

1. Insert the Dolphin into the terminal well of the HomeBase.  If the Dolphin is in sleep mode, it will awaken into active state.

2. The DOCK LED on the cradle will illuminate.  If the Dolphin does not turn on, or the LED does not light up, make sure that it 
is properly seated in the terminal well and that the power supply is properly connected to the cradle and plugged into a 
functioning AC outlet.

3. The Dolphin 9500/9550 terminal will automatically open ActiveSync to establish a connection.  Data can then be transferred 
between the terminal and the devices connected to the Dolphin cradle.  

When data transfer begins, the COMM LED on the cradle will blink red and green for an RS-232 connection or solid green for a 
USB connection.  If the HomeBase will not  communicate with the Dolphin, check the port connections to ensure that the cradle 
is correctly configured.  

ActiveSync Connection Settings
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Mounting the HomeBase

The HomeBase may be desk -mounted for convenience and storage.  The HomeBase may be desk-mounted as long as room 
is allowed for accessibility to the auxiliary battery well.

Desk Mounting:

Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom to allow for secure desk attachment 
of the unit if desired.
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Wall Mounting
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Dolphin® QuadCharger
The Dolphin® QuadCharger provides intelligent battery management for Li-Ion (Lithium Ion) Dolphin 9500/9550 battery packs.

This device fully charges as many as four Li-Ion batteries in four  hours.  Charging slots work independently to control charging 
of individual battery packs.  The QuadCharger is compatible with all models in the Dolphin 9500/9550 family of hand held 
computers.

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries.  The process monitors  changes in temperature, current, and voltage The charger also resets and calibrates battery 
pack data to accurately show battery status on the Dolphin display.

Dolphin QuadCharger Parts and Function

Top Panel 

Charging Pocket

The QuadCharger has four charging pockets for charging batteries for Dolphin 9500/9550terminals.  The fourth charging pocket 
serves as a battery analyzer.  

Battery Analyzer LEDs

Power Switch

Press the toggle switch to turn the QuadCharger on and off.  

Analyzer Switch

Press the Analyzer Switch to start a battery analyze cycle.  

Status LEDs

A Status LED is located above each of the four battery pockets.  

O

SLOT 4BATTERYCAPACITY

100%

0%
ANALYZE

CHARG
CHARGE/AE/ANALNALYZEYZE
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4

Charging Pocket

Status LEDs

Status LEDs

Condition Switch & 
Condition LED

Power Switch & 
Power LED
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Rear Panel

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger.  The universal power supply accepts input voltages between 
90-265 volts.

Charging Batteries In The QuadCharger

Follow these steps to charge batteries in the QuadCharger:

1. Set up the charger for use 

2. Supply power

3. Insert batteries 

CAUTION: Do not attempt to recharge any battery pack in the Dolphin 9500/9550 QuadCharger that is not manufactured 
by HHP especially for this device.  To do so will void your warranty and could damage the Dolphin 9500/9550 
QuadCharger.  

Setting Up The QuadCharger
The Dolphin QuadCharger should be set up on any dry, stable surface.  DIN rail slots on the bottom panel allow the charger to 
be wall or desktop-mounted for easily adapting the unit to your environment.  

The charger must be connected to a power source for any type of operation.  

Supplying Power To The QuadCharger
CAUTION: Using a non-HHP power cord voids your warranty and could result in serious damage to the Dolphin 
QuadCharger’s circuitry.

Locate the AC power cord that came with the Dolphin QuadCharger.  Plug the cord into the power supply connector on the back 
of the unit and then plug the power cord into a wall socket.  

Press the toggle switch to turn on the Dolphin 9500/9550 QuadCharger.  The GREEN power LED will illuminate and the charger 
will undergo a self-diagnostic test.

Inserting and Removing Battery Packs 
To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the 
battery into place with a hinging motion.  Once the battery is properly seated, the orange status LED for that particular pocket will 
illuminate.  

For best results, battery packs should be at room temperature before recharging them; temperature has a marked effect on 
charging.  The recommended temperature range is 50° to 95° F (10° to 35° C).  

The LEDs indicate the charging status of batteries as described in the chart shown on the next page:

Rear Panel of Dolphin 9500/9550Quad Charger

Power Supply Connector
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To remove a battery pack, push the locking tab down and pull the battery out from the charging pocket with a hinging motion.

Analyzing The Battery Pack
To analyze a battery, insert it into charging pocket #4  and press the Analyze button.  The Analyze LED will flash during the 
analyzing cycle.  This starts an automatic process in which batteries are completely discharged and then recharged to full 
capacity in 10 hours.  Upon completion, the battery capacity status is displayed on the LED display.  The Analyze cycle resets 
and calibrates battery data so that the user gets longer, more consistent performance from the batteries.  

Because the Dolphin QuadCharger is accumulating battery pack information during the entire Analyze cycle, it is important not 
to remove the battery until the cycle has been completed and the Condition LED is no longer flashing.  The chart below describes 
the Status LEDs during the Condition and Calibrate cycle:

Storing Batteries
To maintain top performance from batteries, follow the guidelines below when storing them:

Avoid storing batteries outside of the specified temperature range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.

For prolonged storage, do not keep batteries stored in a charger that is connected to a power source.  

Status LED Description

Green
Charging is complete and 
battery is ready for service.  

Orange
Battery is being charged at a 
maximum charge rate

Red
Error was encountered during 
charge cycle

                              Status of LEDs during Charging Cycle

Status LED Description

Solid Green Cycle is complete.  

Flashing Orange Battery is being analyzed

Solid Red Error was encountered during 
charge cycle

          Status of LEDs during Analyze Cycle
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Troubleshooting

If you encounter problems with your Dolphin QuadCharger, refer to chart below for possible solutions.  If problems persist, please 
contact HHP Technical Support.  

Problem Issue

The “CHARGING”  LED does not come on 
when I insert a battery pack into the 
Dolphin QuadCharger

Check the power connections on the 
Dolphin QuadCharger.  Also check to 
ensure the POWER switch is ON and the 
battery pack is properly seated.

The red status LED comes on during 
charging.

Try to charge the battery in one of the 
other charging pockets.  If the red Status 
LED comes on again, then the problem is 
associated with the battery pack.  If the 
red status stays with the charging pocket, 
the problem is associated with the 
charging circuity.

The red status LED remains on without a 
battery in the charging pocket.

An error occurred during the self-
diagnostic test for that particular charging 
pocket.  Call HHP Product Service and 
request an RMA.  See Warranty, Support 
and Service beginning on page 15-1 for 
additional warranty and return 
information.
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Dolphin  Mobile Charging/Communication Cradles
As the hub of  your Dolphin 9500/9550 mobile data collection system, the Dolphin 9500/9550 Mobile Base charging/
communication cradle performs three important functions -- charging, communications and storage.  The charging/
communication cradle is ideal for use with both in-premise warehouse and in-transit data collection applications.

Charging

The charging/ communication cradles provide power to the Dolphin terminal to enable the terminal to charge its battery.

Communications

Reliable data communications at speeds of up to 115K baud can be transmitted by the Mobile Base through the RS-232 serial 
port.

Convenient Storage 

The Mobile Base is a safe and convenient storage receptacle for the Dolphin 9500/9550 terminal.  

Mobile Base Parts and Functions

Front Panel
The front panel of the Mobile Base has one slot:

Front Panel of Dolphin Mobile Base

Terminal 
Well

DOCK LED

COMM              
LED

Spring-Arm Assembly
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Terminal Well  Place the Dolphin 9500/9550 in this well to communicate with a host device and to charge the mobile computer’s  
battery.

LEDs  There are two LEDs on the front panel of the Mobile Base.

1. Dock LED   Turns solid green when the Dolphin Terminal is properly seated into the Dolphin Mobile Base.

2. COMM LED   Indicates the status of data transfer between the Host Device and the Dolphin Terminal as described below:

Comm LED Description

Red LED Data is being sent from the Host Device to the 
Dolphin Mobile Base.  

Green LED Data is being sent from the Dolphin Mobile Base 
to the Host Device.

Orange LED Data is being sent at high data rates.
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Rear Panel

The power supply connector and RS-232 connector are located on the bottom of the unit:

Power supply connector  Use this connector to attach a power supply to the Mobile Base.  The power supply provides power 
for communications and battery charging.

RS-232 Communications Port  Use a standard serial cable to connect this port to a host RS-232 device.  

Powering the Dolphin Terminal

When seated in the Mobile Base, the Dolphin terminal receives the power it needs to charge the battery and to run its internal 
circuitry.

The Dolphin terminal can be stored indefinitely in the Mobile Base without damage to the terminal or the Mobile Base.  Keep the 
Mobile Base plugged in so that the Dolphin terminal battery pack stays fully charged.

Rear Panel of Dolphin Mobile Base

RS-232 
Communications 
Port

Power Supply 
Connector

Mounting 
Bracket
Dolphin® 9500/9550 Mobile Computer User’s Guide 14 - 3



Charging A Dolphin Terminal
The Mobile Base supplies charging power to the Dolphin terminal so that the terminal can monitor the charging of its battery pack.  
This charging method protects the battery from being damaged by overcharging.  Therefore, the Dolphin terminal may be stored 
indefinitely in the Mobile Base without damage to the terminal, the battery pack, or the Mobile Base.

To charge a Dolphin terminal, follow these steps:

1. Insert a battery pack into the Dolphin terminal.

2. Place the terminal, imager window up and the LCD visible, in the Terminal Well of the Mobile Base.  

3. Let it glide down into the well until it stops.  

4. Once the Dolphin terminal is properly seated, the Dock LED on the Mobile Base will be solid GREEN.

Setting Up For Communications with the Mobile Base

The Mobile Base RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any standard 
RS-232 device using a standard serial cable and communications software.

Installing The Dolphin Mobile Base
Mounting the Mobile IntelliBase Spring Arm Assembly

The adjustable mounting bracket holds the terminal securely in place and gives the user a variety of options for mounting the 
Mobile Base.  See the directions below for mounting the bracket.

To attach the bracket:

1. Loosen the turn screw located on the side of the bracket.

Ball joint

Turnscrew
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2. Attach the bracket to the ball joint on the back of the MobileBase and tighten the turnscrew.

Connecting the Cables

Connect the Mobile Base to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the bottom of the Mobile Base.  Plug the other end of the RS-232 serial cable into the correct port on 
the host RS-232 device.  

The wiring of your cable depends on whether the other device is set up as a DCE (Data Communications Equipment) or DTE 
(Data Terminal Equipment) device.  

The Mobile Base Communication Port is configured as a DCE device.  To communicate with a DTE device such as a computer, 
use a standard (or straight-through) RS-232 cable.  To communicate with a DCE device, use either a null modem adapter in line 
with a standard RS-232 cable, or a null-modem serial cable.  
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You can make your own cables by following the pin configuration in the chart below.  To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.

Supplying Power to the Dolphin Mobile Base

The Mobile Base can be powered from a 12 to 48 volt DC source.  Power is connected to the input power connector located on 
the rear of the Mobile Base.  

HHP recommends that you leave the Mobile Base connected to its power source at all times, so that it is always ready to use.

HomeBase /Host 
Port (DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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Configuring the Dolphin Terminal
The Communications Properties must be configured on Dolphin 9500/9550 terminal in order for it to communicate with the Mobile 
Base.

To set Communications Properties:

1. Select Start>ActiveSync>Tools>Options.  

2. Select the PC Connection tab.

3. Check the Enable Synchronization check box.

4. Select the appropriate baud rate for connecting to the RS-232 Host Device.  Click OK and close the ActiveSync window on 
the Dolphin 9500/9550.

5. Place the Dolphin in the Mobile Base.

Communications Properties
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Warranty, Support and Service
Limited Warranty

Hand Held Products, Inc., d/b/a HHP ("HHP") warrants its products to be free from defects in materials and workmanship and to 
conform to HHP’s published specifications applicable to the products purchased at the time of shipment.  This warranty does not 
cover any HHP product which is (i) improperly installed or used; (ii) damaged by accident or negligence, including failure to follow 
the proper maintenance, service, and cleaning schedule; or (iii) damaged as a result of (A) modification or alteration by the 
purchaser or other party, (B) excessive voltage or current supplied to or drawn from the interface connections, (C) static electricity 
or electro-static discharge, (D) operation under conditions beyond the specified operating parameters, or (E) repair or service of 
the product by anyone other than HHP or its authorized representatives.

This warranty shall extend from the time of shipment for the duration published by HHP for the product at the time of purchase 
("Warranty Period").  Any defective product must be returned (at purchaser’s expense) during the Warranty Period to HHP’s 
factory or authorized service center for inspection.  No product will be accepted by HHP without a Return Materials Authorization, 
which may be obtained by contacting HHP.  In the event that the product is returned to HHP or its authorized service center within 
the Warranty Period and HHP determines to its satisfaction that the product is defective due to defects in materials or 
workmanship, HHP, at its sole option, will either repair or replace the product without charge, except for return shipping to HHP.

EXCEPT AS MAY BE OTHERWISE PROVIDED BY APPLICABLE LAW, THE FOREGOING WARRANTY IS IN LIEU OF ALL 
OTHER COVENANTS OR WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

HHP’S RESPONSIBILITY AND PURCHASER’S EXCLUSIVE REMEDY UNDER THIS WARRANTY IS LIMITED TO THE 
REPAIR OR REPLACEMENT OF THE DEFECTIVE PRODUCT.  IN NO EVENT SHALL HHP BE LIABLE FOR INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, AND, IN NO EVENT, SHALL ANY LIABILITY OF HHP ARISING IN 
CONNECTION WITH ANY PRODUCT SOLD HEREUNDER (WHETHER SUCH LIABILITY ARISES FROM A CLAIM BASED 
ON CONTRACT, WARRANTY, TORT, OR OTHERWISE) EXCEED THE ACTUAL AMOUNT PAID TO HHP FOR THE 
PRODUCT.  THESE LIMITATIONS ON LIABILITY SHALL REMAIN IN FULL FORCE AND EFFECT EVEN WHEN HHP MAY 
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH INJURIES, LOSSES, OR DAMAGES.  SOME STATES, PROVINCES, 
OR COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

All provisions of this Limited Warranty are separate and severable, which means that if any provision is held invalid and 
unenforceable, such determination shall not affect the validity of enforceability of the other provisions hereof.

The limited duration of the warranty for the Dolphin 9500 and Dolphin 9550 terminals is as described below:

• Terminals with an integrated imager are covered by a two-year limited warranty.   

The limited duration of the warranty for the Dolphin HomeBase, Mobile Base, Mobile Charger, and QuadCharger is for one year.  

The limited duration of the warranty for batteries is one year.  The battery life will be greatly increased when following the specific 
battery instructions in the user guide.

Batteries returned to HHP in this reduced state may or may not be replaced under this warranty.

Use only power adapters approved for use by HHP.  Failure to do so may result in improper operation or damage to the unit and 
will void the warranty.

Hand Held Products, Inc. extends these warranties only to the first end-users of the products.  These warranties are non-
transferable.

How Problems Should Be Handled

Should the Dolphin terminal or any of the peripherals prove to be defective within the stated warranty period from the of date of 
purchase, return the product, as described in the RMA procedures below, and we will, at our option, repair or replace the product, 
to whatever extent HHP deems necessary to restore the product to proper operating condition, without any charge to you.

Return Information

If you purchased the product from an Authorized HHP Reseller, contact the Reseller with the unit's serial number.  Your Reseller 
will contact HHP, on your behalf, to arrange for the unit to be serviced.

If you purchased the product directly from HHP, or have been instructed by your Reseller to contact HHP directly, call the 
Customer Services Department in your area to request a Repair Maintenance Authorization (RMA) number.  
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North America

HHP Corporate Offices
Telephone:  (800) 782-4263, option 3
Fax:  (704) 566-9904
E-mail:  ProductService@hhp.com

Canada

HHP Repair Service available through:
National Service Center
Telephone: (800) 500-6421
Fax:  (864) 676-4277
E-mail:  canada.hhp.repair@nationalservicecenter.com

Latin America

HHP Latin America
Telephone: (941) 263-7600
Fax:  (941) 263-9689

Mexico

HHP Repair Service available through:
National Service Center
Telephone: (800) 500-6421
Fax:  (864) 676-4277
E-mail:  mexico.hhp.repair@nationalservicecenter.com

Brazil

HHP Brazil
Telephone:  +55 (21) 2494-7060
Fax:  +55 (21) 2494-5033
E-mail: suporte@hhp.com.br

Europe, Middle East, and Africa

HHP Europe
Telephone:+ 31 (0) 40 29 01 633
Fax: + 31 (0) 40 2901631
E-mail: EuroService@hhp.com

Asia Pacific

HHP Asia/Pacific
Telephone:   +852-2511-3050 
Fax:   +852-251-13557
E-mail:  chuie@hhp.com

You must have an RMA number to receive service from any of  HHP’s repair facilities.  Failure to obtain an RMA number before 
shipping your product to this repair facility can delay the processing of your repair request.  

When calling for service at any of our repair facilities, please be prepared to give the following information:

• ·Product's type and serial number 
• ·Brief description of problem 
• ·Dated Proof-of-Purchase

Place the product in its original packaging with a copy of your original invoice and ship the product prepaid to the appropriate 
address below.  Write the RMA number on the mailing label under the address.
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If your equipment is still covered under the initial end-user's product warranty, please notify the Product Services Representative 
when you call.  Please include a copy of the original invoice in the package to avoid possible service delays.  For your protection, 
we recommend you insure any equipment being sent to HHP.

After repair or replacement of the equipment, HHP will ship the product, at our cost, to your location.  Non-warranty repairs will 
be returned, at the customer's expense, unless otherwise requested.  Units currently under a service agreement will be shipped 
per the service agreement.

Please make note of the RMA number (if required) before shipping and the product's serial number for future reference.

How To Extend Your Warranty

HHP offers a variety of service plans on our hardware products.  These agreements offer continued coverage for your equipment 
after the initial warranty expires.  For more information, contact your HHP sales representative, customer account representative 
or the Product Service Marketing Manager or your Authorized Reseller.  

Application Support

If you have a question or problem with your Dolphin terminal or Dolphin peripheral, you can get technical assistance from HHP’s 
Application Support department.  

North and South America:

HHP

Products Services Department

7510 East Independence Blvd., #100

Charlotte, NC 28227-9411

Europe, Middle East and Africa:

Nijverheidsweg 9

5627 BT Eindhoven

The Netherlands

The United Kingdom:

Dallam Court

Dallam Lane Warrington

Cheshire WA2 7LT

United Kingdom

Asia/Pacific

10/F Tung Sun Commercial Centre

194-200 Lockhart Road

Wanchai, Hong Kong

Japan Office

Bon Marusan 8F

3-5-1 Kanda-Jinbocho

Chiyoda-ku

Tokyo 101, Japan

Latin America Office

5117 Castello Drive

Suite 1

Naples, FL 34103
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Appendix A 
Use the keyboard shortcuts in the chart below to navigate the Dolphin 9500 and Dolphin 9550 terminal keyboards.

Windows Keyboard Shortcuts

Press To

CTRL + C Copy

CTRL + X Cut

CTRL + V Paste

CTRL + Z Undo

DELETE Delete

CTRL + RIGHT ARROW Move the insertion point to the beginning 
of the next word.

CTRL + LEFT ARROW Move the insertion point to the beginning 
of the previous word.

CTRL + DOWN ARROW Move the insertion point to the beginning 
of the next paragraph.

CTRL + UP ARROW Move the insertion point to the beginning 
of the previous paragraph.

SHIFT with any of the arrow keys Select more than one item in a window or 
on the desktop, or select text within a 
document.

CTRL+A Select all.

ALT+ENTER View properties for the selected item.

ALT+TAB Switch between open items.

ALT+ESC Cycle through items in the order they were 
opened.

ALT + Tap on Touch screen Right click

CTRL+ESC Display the Start menu.

ALT+Underlined letter in a menu name Display the corresponding menu.

Underlined letter in a command name on 
an open menu

Carry out the corresponding command.

BACKSPACE View the folder one level up in My 
Computer or Windows Explorer.

ESC Cancel the current task.
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Using the Modifier Keys

The Dolphin 9500/9550 terminal keyboard features the standard Windows modifier keys, Alt, Ctrl and Shift.  The Shift key only 
modifies the next key pressed; it must be pressed before each key you wish to make lower case.  For multiple lower case 
characters, hold the Shift key down with one hand while typing with the other.  Functions of the Alt and Ctrl keys are dependent 
on the software application in use.

There are two additional modifier keys located on the bottom row of the keyboard.  The Red and Blue keys only modify the next 
key pressed; these keys must be pressed and released before each key you wish to modify to the Blue or Red case.  Use these 
keys in combination with other keys to type the corresponding color-coded characters and functions.  See the charts below for 
key combinations that access the functions and special characters using these keys.

43-Key Alpha/Numeric Keyboard

Blue Key Functions & Characters For 43-Key Alpha/Numeric Keyboard

Key Combination Function/Special Character

Double tap Blue key Activate/Deactivate Mouse Utility

Blue key +  D - (minus)

Blue key +  H _ (underscore)

Blue key +  L =

Blue key +  P +

Blue key +  Q ;

Blue key +  R :

Blue key +  S *

Blue key +  T /

Blue key +  U @

Blue key +  X \

Red Key Functions & Characters For 43-Key Alpha Shifted Numeric Keyboard

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  Q F1

Red key +  R F2

Red key +  S F3

Red key +  T F4
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* Exit the mouse utility prior to adjusting the contrast.

Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 43-key version of the Dolphin 9500/9550 keyboard.

Red key +  U F5

Red key +  V F6

Red key +  W F7

Red key +  X F8

Red key +  Y START

Red key +  Z INS (insert)

Red key +  SP BKSP (backspace)

Red key +  BACKLIGHT KEY DEL (delete)

Key Combinations Using NUM & SFT Keys

Key/Key Combination Function/Special Character

NUM + SFT + A !

NUM + SFT + B @

NUM + SFT + C #

NUM + SFT + E $

NUM + SFT + F %

NUM + SFT + G ^

NUM + SFT + I &

NUM + SFT + J *

NUM + SFT + K (

NUM + SFT + M >

NUM + SFT + N )

NUM + SFT + O <

Red Key Functions & Characters For 43-Key Alpha Shifted Numeric Keyboard

Key Combination Function/Special Character
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35 Key Numeric/Alpha 

Key Combinations Using Blue & SFT Keys

Key/Key Combinations Function/Special Characters

Blue + SFT + T ?

Blue + SFT + X |

Miscellaneous Key Combinations

Key/Key Combinations Function/Special Characters

NUM + ALT + 3 + 9* ‘

NUM + ALT + 3 + 4*

*Hold the ALT key down as you type in the numbers.

“

Blue Key Functions & Characters For 35-Key Numeric/Alpha Keyboard

Key Combination Function/Special Character

Double tap Blue key Activate/Deactivate Mouse Utility

Blue key +  . +

Blue key +  , -

Blue key +  F1 ;

Blue key +  F2 :

Blue key +  F3 /

Blue key +  F4 \

Blue key +  SP _

Blue key + DEL @

Blue key + 0 (zero) =
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Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 35-key version of the Dolphin keyboard.

56 Key Full Alpha Numeric

Key Combinations Using ALPHA & SFT Keys

Key/Key Combination Function/Special Character

ALPHA + SFT + 1 !

ALPHA + SFT + 2 @

ALPHA + SFT + 3 #

ALPHA + SFT + 4 $

ALPHA + SFT + 5 %

ALPHA + SFT + 6 ^

ALPHA + SFT + 7 &

ALPHA + SFT + 8 *

ALPHA + SFT + 9 (

ALPHA + SFT + 0 )

ALPHA + SFT + .  (period) >

ALPHA + SFT + , (comma) <

Miscellaneous Key Combinations

Key/Key Combinations Function/Special Characters

ALT + 3 + 9* ‘

ALT + 3 + 4*

*Hold the ALT key down as you type in the numbers.

“

Blue Key Functions & Characters For 56-Key 
Full Alpha Numeric Keyboard

Key Combination Function/Special Character

Double tap Blue key Activate/Deactivate Mouse Utility

Blue key +  . +
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Blue key +  , -

Blue key +  A ;

Blue key + B :

Blue key +  C /

Blue key +  D \

Blue key +  E _

Blue key +  F @

Red Key Functions & Characters for 56-Key
Full Alpha Numeric Keyboard

Key Combination Function/Special Character

Red key +  ESC Lightens Contrast*

Red key +  TAB Darkens Contrast*

Red key + SFT Toggles on Caps Lock

Red key +  A F1

Red key +  B F2

Red key +  C F3

Red key +  D F4

Red key +  E F5

Red key +  F F6

Red key +  G F7

Red key +  H F8

Red key + I F9

Red key + J F10

Red key + K F11

Red key + L F12

Red key + M F13

Red key + N F14

Red key + O F15

Blue Key Functions & Characters For 56-Key 
Full Alpha Numeric Keyboard

Key Combination Function/Special Character
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* Exit the mouse utility prior to adjusting the contrast.

Key Combinations 
Use the key combinations listed below to access certain keyboard functions or to use special characters that are not defined on 
the 56-key version of the Dolphin keyboard.

Red key + P F16

Red key + Q F17

Red key + R F18

Red key + S F19

Red key + T F20

Red key + U F21

Red key + V F22

Red key + W F23

Red key + X F24

Red key + Y Z

Key Combinations Using SFT & Number Keys

Key/Key Combination Function/Special Character

 SFT + 1 !

SFT + 2 @

SFT + 3 #

SFT + 4 $

SFT + 5 %

SFT + 6 ^

SFT + 7 &

SFT + 8 *

SFT + 9 (

SFT + 0 )

SFT + .  (period) >

SFT + , (comma) <

Red Key Functions & Characters for 56-Key
Full Alpha Numeric Keyboard

Key Combination Function/Special Character
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Miscellaneous Key Combinations

Key/Key Combinations Function/Special Characters

ALT + 3 + 9* ‘

ALT + 3 + 4*

*Hold the ALT key down as you type in the numbers.

“
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